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Introduction

Introduction

This guide provides information and procedures for using quality assurance (QA) functions on cc:
Discover’s Coaching and Web Player tabs. Those functions include creating evaluation forms, performing
evaluations, setting up content libraries, establishing achievement awards for agents, and running various
reports.

The guide assumes that the user is familiar with:

e Basic Quality Management (QM) concepts and processes.
e Basic Windows PC usage such as right and left clicking the mouse.
e Usage of the cc: Discover Web Portal.

Please contact your system administrator for the cc: Discover Web Portal URL and for access
permissions to the necessary functions.

Note The cc: Discover platform allows administrators to customize field names and terminology in the
Web Portal to fit your unique environment. Therefore, screen examples and field names used in this
manual may differ from those seen in your implementation.
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Create a QA Evaluation Form

Create a QA Evaluation Form

This section explains how to create Quality Assurance (QA) evaluation forms for reviewing the work of
agents including how they handle calls. Authorized users/evaluators use the forms in the cc: Discover
Web Player and Coaching tabs to record scores and comments. Score data collected from the forms is
used for reporting.

Before creating a form, CallCopy recommends:

Reviewing this document to understand what types of questions and responses can be used.

Writing the evaluation questions, responses, and possible points in a document. This approach allows
users to share the evaluation questions with other managers, and it separates the process of writing
the evaluation content from the process of creating the evaluation form.

Promoting consistent scoring across forms by creating a question points/value schema that is easy to
track and used by all form creators.

Remember these points when creating a form:

Save a QA form before switching to another tab. Changing tabs without saving will cause all changes
to be lost.

Do not use the form until you are certain you have added all the sections and questions necessary.
Forms cannot be changed after they are used for an evaluation. A new form can be created from a
used form.

Groups can be added to and removed from a used form.

The number of elements that can be in a single QA form is determined by the number of controls the
environment and browser allow. By default, cc: Discover allows 2000 controls to be displayed in a
single form. When this limit is reached, no more sections, questions, or responses can be added
without removing others first.

CallCopy software considers angled brackets (< >) in QA forms to be HTML, which is not supported.
If these characters are used in a form or response, the form will not save. Use square brackets [ ] or
braces { } instead.

To create a QA evaluation, complete these steps:

o gk wbdhPE

Name and assign groups to the form.

Add a section.

Add a question to the form.

Add responses to the question. Steps 2, 3 and 4 are repeated as necessary.
Move questions and responses as needed.

Save the form.

cc: Discover QA Coaching Manual, v5.3



Create a QA Evaluation Form

Step 1: Name and Assign Groups

In the cc: Discover Web Portal, click the Coaching tab. The
Quiality Assurance menu appears on the left side of the page.

Guality Assurance

Create Form
Manage Forms In the Quality Assurance menu, click Create Form.
Perform QA

Search A Evaluations

Search QA Acknowledgments

Form Name

In the QA Form Editor, type a unique and descriptive name in the "Form Name" field (50 characters max).
In the example below the name is "Customer Service Evaluation." To help ensure historical accuracy and
continuity in reporting, a form cannot be edited once it has been used. However, you can alter a scored
form and then save it as a new form. Therefore, a best practice is to include a version number in the form
name, so that new versions of forms can be easily identified.

Acknowledgment

Select the Agent Acknowledgment Required option if agents must acknowledge that they have
reviewed their evaluations. If agents can login to cc: Discover, they will receive evaluation notices on the
Home tab. If agents have email addresses recorded in cc: Discover, they will receive notices at that
address. If this option is not selected, evaluators still have the option when performing reviews whether to
notify agents.

Note This is the evaluation email-notification text: "A Quality Assurance Evaluation has been
completed and Assignment Request has been sent to you. Please review your Assignment Inbox."
Server administrators can edit this text and the email subject line in the Web.config file’s
QAMailSubject and QAMailBody keys. (Go to Program Files > CallCopy > WebPortal.) Changing
other settings in this file can negatively affect cc: Discover.

QA Form Editor | Export I Import - Save |

QA Form Info

D Agent Acknowledgment Required [Default

Form Hame: Customer Service Evaluation
Valure)

Un-Attached Groups Attached Groups

Calibration
ClientABC
ClientXvZ
Janes Team
Johns Team
Sales Team
Support Team

QA Form
Create New Section

cc: Discover QA Coaching Manual, v5.3 7



Create a QA Evaluation Form

Groups

Groups are the CallCopy groups that administrators create and to which agents can be assigned. They
usually represent business organizational units or projects. (CallCopy Groups are covered in the cc:
Discover Web Player Manual and cc: Discover Administration Manual.)

Agents have to be in groups to be evaluated, and forms have to be attached to groups to be used.

In the Un-Attached Groups list, click one or more groups that may use the form, and then click the right
arrow. Reversing the procedure un-attaches groups.

To help ensure historical accuracy and continuity in reporting, a form cannot be edited once it has been
used. This includes unattaching groups whose members have been scored using the form. If you need to
remove a group from a previously-scored form, create a new version of the form. For details, see Form
Name.

Un-Attached Groups Attached Groups
Johns Team = Calibration
Sales Team ClientABC
Support Team Client:{vZ

Janes Team

Step 2: Add a Section

Sections organize a form. They usually follow the type of call flow that occurs. For example, for a
technical support QA form, logical sections might be "Greeting," "Soft Skills," "Use of Desktop Tools," or
"Call Closing." A form must have at least one section. All questions can be placed in one section.

. . Create Mew Section
To create a section, click - J

Add a unique name in the Section Title field (50 characters max).

Section Title:

8 cc: Discover QA Coaching Manual, v5.3



Create a QA Evaluation Form

Step 3: Add a Question Type

The form will probably need multiple questions. Repeat steps 2 and 3 for each question.

Evaluators use questions to score the call. Questions have responses assigned to them.

Add New Question |

To create a question, click |

A question text and type object will appear. Type the question text (1024 characters max). For example,
the question can be "Did the agent use the standard greeting?"

Question Type: Dropdown El Critical: |:|

Question:

One question on a form can be designated as Critical. Responses to and scores on this question are
tracked by the Critical Question Detail and Critical Question Summary reports. For example, critical
question could track if the agent asked for the customer’s email address to support future marketing
efforts.

Select the question type. There are five types:

= Dropdown (Scoring)

= Horizontal Radio (Scoring)
= Vertical Radio (Scoring)

* Free Text (Non-Scoring)

= Comment (Non-Scoring)

cc: Discover QA Coaching Manual, v5.3 9



Create a QA Evaluation Form

Dropdown

Responses appear in a drop down menu, and the evaluator can select one.

For example, a question with responses ranging from "Exceeds Expectations"” to "Fails Expectations" with
point values ranging from ten (10) for "Exceeds Expectations" to zero (0) for "Fails Expectations" would
appear in the Form Creator like this:

Question Type: Dropdown El Critical: I:‘

Question:

Dropdown guestion text goes here.

b T X Response: Excesds Expectations Auto Fail: Mone E' Default:[?

Possible Points: 10

- X Response: Meets Expectations Auto Fail:  MNone El Default: [

Possible Points: 5

b T X Response: Failed Expectations Auto Fail: Forms El Default:D

Possible Points: 0

This example will appear like this in the completed form:

Dropdown guestion text goes here. Exceeds Expectations | =
Select

Exceeds Expectations
Meets Expectations
Failed Expectations

10 cc: Discover QA Coaching Manual, v5.3



Horizontal Radio

Create a QA Evaluation Form

Responses appear on the form as circular Radio buttons displayed in a horizontal line.

For example, a question with responses of "Yes," "No," and "Not Applicable" would appear in the Form

Creator like this:

Question Type: Herizental Radie Buttons EI

Question:

Critical: [ |

Horizental Radio question text is entered here.

st Response: Yes Auto Fail: None El Default: (W]
Possible Points: 5

v Response: No Auto Fail: Nene El Default:D
Possible Points: 0

v Reszponse: Mot Applicable Auto Fail:  Nene El Default:lj
Possible Points: NA

This example will appear like this in the completed form:
Horizontal Radio question text is entered here. ves Mg C'Not Applicable

cc: Discover QA Coaching Manual, v5.3
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Create a QA Evaluation Form

Vertical Radio

Responses appear on the form as circular Radio buttons displayed in a vertical column.

For example, a question with responses of "None,

like this:

One," and "Two" would appear in the Form Creator

Question Type: “Vertical Radio Buttons

Question:

[=]

Critical: [_|

“Vertical Radio question text is entered here.

v X Response: None

Possible Points: S

v X Response: One

Possible Points: 3

v X Response: Two

Possible Points: 1

Hane El Default: [

None El Default: [

MNone (=] Default: [

This example will appear like this in the completed form:

“Vertical Hadio guestion text iz entered here.

_'Mone

0One

ATwo

12
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Create a QA Evaluation Form

Free Text

This is general free text field that the evaluator can use to give a descriptive analysis. Point values
cannot be associated with a Free Text response, so responses to questions of this type do not apply to
the overall percentage score of the form. You will have the option to require a response with Free Text,
which requires that at least one character (and up to 1024 characters, including spaces) be placed in the

field.

Question Type: Free Text El Response required:

Question:
Free Text text is entered here.

This example will appear like this in the completed form:

Free text text is entered here.

Comment

This is a note that can be left on the form to describe the question or provide extra instructions or details.
This is not a question, but rather informative text that appears on the QA form for the evaluator’s benefit.

Max 220 characters, including spaces.

Question Type: Comment El

Comment:
Comment text is entered here and will appear in italics.

This example will appear like this in the completed form:

Comment text iz entered here and will sppesar in italics.

cc: Discover QA Coaching Manual, v5.3 13



Create a QA Evaluation Form

Step 4: Add Responses

Note Questions can have an unlimited number of responses. You have to repeat this task for each
response.

Add New Response |

To specify the responses an evaluator can provide, click |
Enter an option in the Response text field.
These settings can be used or left blank:

e Auto-fail: If the evaluator selects a response designated as Auto Fail, then the agent fails the Section
or the entire Form. This setting is typically used to enforce service-affecting protocol, such as security
verifications or adherence to scripts with legal disclaimers.

o Default: Selecting the Default option causes the response text to appear in the question’s response
field on the form.

e Possible points: This value provides a score for the response. During evaluation and scoring, cc:
Discover adds the points scored on each question and divides that value by the total of the highest
possible points for all applicable questions. This calculation generates a percentage score for a form.
Responses that are specified as Auto Fail MUST have a Possible Points value of 0.

Question Type: Dropdown - Critical:

Question:

Did the agent understand the products?

Response: Excellent Auto Fail: MNone *  Default:

Possible Points: =

Response: Yery Good Auto Fail: None ¥  Default:

Possible Points: 4

Response: Good Auto Fail: None >  Default:

Possible Points: 3

Response: Fair Auto Fail: Moene hd Default:

Possible Points: £

Response: Poor Auto Fail: Mone - Default:

Possible Points: 1

In the example above, the question is set to "Dropdown," so on the form the possible responses will be
seen as options in a dropdown menu.

If the response is "Excellent," the evaluation will have five points added to the total score. A response of
"Very Good" will earn four points, "Good" will earn three points, "Fair" will earn two points, and "Poor" will
earn one point.

14 cc: Discover QA Coaching Manual, v5.3



Create a QA Evaluation Form

If a question may not be applicable to all calls, include a ‘Not Applicable’ response option. If the evaluator
selects this option, and enters NA or na in the Possible Points field, the question’s available points will not
be counted toward the section or form totals.

Note Not Applicable questions can be assigned a point value. That value can affect the final score
because it is counted towards the section and form totals. However, assigning Not Applicable
questions the highest possible value will have no effect on the agent’s final score.

Question :  Horizontal Radio question text is entered here. Type : | Horizontal Radio El
Response : Yes Possible Points : | 5 Auto Fail: | None El Defautt :
Response : No Possible Points : 0 Auto Fail: | None El Defautt :
Response : Not Applicable Possible Points : na Auto Fail : | None El Default :

cc: Discover QA Coaching Manual, v5.3 15



Create a QA Evaluation Form

Step 5: Move Form Items

Use the sequence buttons

. “ Moves the selected item up.

° ~ Moves the selected item down.
e " Removes the item entirely.

Example Form:

to set the order of QA Form items:

Form Name ;| Form for Manual
Un-Attached Groups
ClientABC
ClientrZ
Janes Team
Johns Team
Sales Team
Support Team
- X 2 Section Name : Section 0
4 X 2 Question :  Dropdown guestion text is entered here.
X Rezponze : Excellent Possible Points
- X X Response : Very Good Possible Points
4 ¥ X Response : Good Possible Points
- ¥ X Responsze: Fair Possible Points
- ¥ X Response : Foor Possible Points -
Create New Response
a ¥ Question :  Horizontal Radio question text is entered here.
o, X Responsze: ‘Yes Posszible Points :
a X Response: Mo Possible Points :
— Response : Mot Applicable Possible Points
Create New Response
- ¥ X Question :  Vertical Radio question text is entered here.
A X 2 Response: Mone Possible Points :
= X Response . One Possible Points :
= X Response . Two Possible Points :
Create New Response
P Question : Free text text is entered here.
¥ Question : Comment text iz entered here and will appear in italics.

o

na

Auto Fail

Auto Fail :

Auto Fail :

Auto Fail :

Auto Fail -

Auto Fail :

Auto Fail:

Auto Fail:

Auto Fail:

Auto Fail

Auto Fail :

Agent Acknowledgment Required (Default Value)

Attached Groups
Calibration -
Type : Dropdown E|
Nene El Defautt : [
None El Defautt : [
None El Defautt : [C]
None E| Defautt : [
Mone E| Defautt : [
Type : Herizontal Radie El
None E| Defautt : [
Nene E| pefautt :[]
Nene El pefautt - []
Type : Vertical Radio El
None [] pefaut : [
Nene El Defautt : [
Nene El Defautt :[]
Type ;| Free Text E| Respnnse reguired
Type : Comment El
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Create a QA Evaluation Form

Step 6: Save a Form

[ Save

To finish building a form, click LA preview of the form will appear.

If the form needs changes, click Manage Forms under the Quality Assurance menu. The QA Forms
Listing page opens. The form must be retrieved using the Filter. For details, see Manage OA Forms.

Note You can alter a form once it is saved and before it has been used in evaluating a call, but once
the form has been used, it will be locked from editing. Do not use the form until you are certain you
have added all the sections and questions necessary.

@A Form Editor

Form for Manual

Section 0
Dropdown guestion text goes here. Exceeds Expectations El
Horizontal Radio question text is entered here. @ves CDINe DNot Applicable
CiNone
Vertical Radio gquestion text is entered here. “Jone
OTwo

Free Text text iz entered here.

Comment text is entersd here and will appear in italics.

cc: Discover QA Coaching Manual, v5.3 17



Manage QA Forms

Manage QA Forms

Search for Existing QA Forms

The Manage Forms menu allows you to view Quality Assurance forms already added to the system.

1. Onthe Coaching tab’s Quality Assurance menu, click Manage Forms.
2. Onthe QA Forms Listing page, select the search criteria.

= Form State: The options for Form State are All, Active, and Disabled. Active forms are available
to users who have permissions to perform QA evaluations. Disabled forms are not currently used
to perform evaluations.

= Groups: (Optional) Groups are the CallCopy groups that administrators can create and to which
agents can be assigned. They usually represent business organizational units or projects.

Q& Forms Listing Fiter

Form State: A1 w | Growp : Al w

3. Click Filter. Alist of forms appears. Forms are listed by their creation date.

QA Forms Listing Fitter
Form State: Active El Group: All El
Form Name : Sales Evaluation Status: Active
Edit by: NIA
Create Date : 3162006 11:16:21 AM Dizable Date : 12/30/1899 12:00:00 PM Edit Dizable
Forms Completed : 2304 Last Form : 81772010

For each form listed, the following summary information is displayed:

= Form Name: Name of the form assigned in the QA Form editor.

= Edit by: User name of the last person to change the form.

» Create Date: Date the form was created.

» Forms Completed: Number of times an evaluation has been submitted with this particular form.

» Status: Active or Disable.

= Disable Date: Date the form was last disabled. (If it has never been disabled, the field says
“12/31/9999'.)

= Last Form: The last time the form was used to evaluate an agent.
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Edit Existing Forms

An existing QA form:

Manage QA Forms

e Cannot be edited if it ever was used to evaluate an agent, even if the evaluation has since been
deleted. This applies to both completed and in-progress evaluations. Changing a form used for an

evaluation would alter any reporting based off of it.

e Can be saved as a new version if it has been used to evaluate agents.
e Can be attached to CallCopy groups, even after the form has been used. Once it has been used, it
cannot be un-attached from its existing groups. If the form has not been used, un-attaching a group

prevents users from evaluating that group with the form.

Change Group Attachments

You can edit an existing QA form to attach or un-attach groups from the form. Once the form has been
used to evaluate agents, new groups can be attached but existing groups cannot be un-attached.

To edit an existing form in the QA Form Editor, locate the form and click lﬂl. Make the necessary

changes and click Save.

Create a New Form from an Existing Form

You can create a new form from a form that has previously been used to score agents or calls. A new

form cannot be created from a form that has not yet been used.
Follow these steps:

1. Locate the form using the QA Form Editor and click Edit.
2. Change the name of the form.

3 CIiCkl Alter Scored Form ]

QA Form Editor

@A Form Info

Form Name: Customer Service Evaluation

Un-Attached Groups Attached Groups

Calibration ClientABC
ClientXyZ
Janes Team
Johns Team

Sales Team
Support Team

This form has already been scored
and cannot be edited. A new form will
be created if altered.

4. Make the necessary changes to the form. Click Save.

| Export || Import || Back | | Save |

[Dlagent acknowledgment Required (Defautt Value)

Alter Scored Form

The new form will not save if a different name has not been entered in the Form Name field.

cc: Discover QA Coaching Manual, v5.3
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Manage QA Forms

Disable/Enable Forms

Active forms are available to users who have permissions to perform QA evaluations. Disabled forms are
not currently used to perform evaluations. A form can be disabled and enabled an unlimited number of
times. Forms cannot be deleted. Disabling a form assures that it is not accidentally used and makes the
forms list shorter.

A disabled form cannot be used to perform a new evaluation. However, if a form is used to perform a
completed or in-progress evaluation and the form is later disabled, the evaluation can still be edited or
completed.

To disable a form, find the form on the QA Forms listing and click Disable. The form’s Status field
changes from Active (green) to Disabled (red). To enable a form, reverse these steps.

Import/Export Forms

The CallCopy user community provides XML documents that can be imported to create QA forms. These
customizable documents serve as templates with standard questions, responses, and point values. Some
documents include Healthcare QA Evaluation, Performance Review, Sales Evaluation, and Technical
Support Evaluation. (Clients can access the user community through the CallCopy Web site.)

Follow these steps to import an XML document:

1. Download the CallCopy XML form template to your PC.

2. On the Coaching tab, click Create Form in the Quality Assurance menu.

3. Inthe QA Form Editor, name the form and attach any groups that will be evaluated using the form.
4. Click Import. Click Browse and navigate to the XML file.

Import QA Form X

Select a form to upload (XML documents anly) :

Browse. .

| Import Il Cancel |

5. Select it and click Open. Click Import.
6. The form will be created. Edit it as needed and click Save.

To export an existing form as an XML document, click Manage Forms. Find the form and click Edit.
When the form opens, click Export. Save the form, making sure that it is saved as File Type XML.
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Perform Evaluations

Performm Evaluations

An evaluator can perform an evaluation on a call record made by an agent or on an agent’s non-call work.
While performing an evaluation, the evaluator can save an incomplete evaluation to be completed at a
later time.

Incomplete evaluations are saved with a status of In Progress. An in-progress evaluation can be edited
and saved multiple times before submitting the completed evaluation. In-progress evaluations cannot be
sent to the agent for acknowledgment and do not appear in the Assignment Inbox or on widgets until they
are completed.

To perform QA evaluations, an evaluator must have Coaching Permissions, access to the CallCopy group
attached to the QA form used for the evaluation, and permissions for the cc: Discover Web Player. These
permissions are set by the cc: Discover administrator and are explained in the cc: Discover Administration
Manual.

Evaluate a Call Record

Call record evaluations are done on the cc: Discover Web Player tab.

1. Select the calls to be evaluated using the filtering tools.

2. Onthe call record to be evaluated, right-click and select the Evaluate this Agent option from the
Context Menu.

3. Select whether you want the web player to open up in a standalone window or at the bottom of the
pane. Also select whether you want the web player to display video (i.e., screen capture information)
if it is available.

1212 REME BRIl EY 0 = 1/24/2013 5:13:23 |
> Pla 3

1) v 0 - 1/24/2013 5:11:25 1
#*  Flag

1) 0 - 1/24/2013 5:09:101
4 Export Selected

1! 0 - 1/24/2013 5:08:53 1

Export Call List

]- Ll 1 A fan 2 I:-i'lTu'l"!I
+  Evaluate this Agent » In Current Window » With Video

11 il
¥ View Completed Evaluations In New Window » Without Video

].' = LT e ST S St S ..rn.-..-.-\.J I

View Completed Survey

1! 0 - 1/24/2013 5:03:18 |

Bookmark
oy n n

1 & Archive Options 3 91.0 %% 1/24/2013 5:02:53 |

1 B Categorize , 0 - 1/24/2013 5:01:38 |

1! Edit call 2 93.0 %6 1/24/2013 5:01:351

11 Copy Call Link 0 - 1/24/2013 5:00:44 1

1l % Delete Call 0 - 1/24/2013 4:59:25 |

1i=a= RITAHM AC RATI I FI¥ al - 1/fAMNA2 A.E58.8&8 1
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4. A listing of the QA forms attached to the CallCopy Group(s) associated with the record will appear.
Double-click the form you want to use to score the recording.

Note The agent who conducted a call may be in multiple groups, and one form may be attached
to several groups. Therefore, the same form may be available under several different Groups.
Make sure you select the form with the appropriate Group. Form and Group selections will affect

reporting.
Agent Forms Listing Back
Form Name - Group Name Create Date
Customer Service Evaluation ClientABC S/26/2011 9:35:08 AN
Customer Service Evaluation Sales Team S/26/2011 9:35:06 AN
Customer Service Evaluation Support Team E/26/2011 9:35:06 AW
Customer Service Evaluation 3 CligntaBC 31902006 2:30:23 PM
Customer Service Evaluation 3 Sales Team 3MBI2006 2:30:23 PN 3
Customer Service Evaluation 3 Support Team 31802008 2:30:23 PM
Customer Service Evaluation 4 ClientABC SI26/2011 §:38:18 AN
Customer Service Evaluation 4 Sales Team SI26/2011 9:38:18 AN
Customer Service Evaluation 4 Support Team 52602011 9:38:18 AN
Customer Service Evaluation 5 Sales Team S/26/2011 2.16:13 PM
Sales Evaluation Form Sales Team SI26/2011 4:29:00 PM
Web Player b4
Screen Capture Zoom Panel Tags
e ) BBCS Tech CRM - Mozilla Firefox #© & O
e BT File Edit Wiew History Bookmarks Tools Help 17 | 01:25 65  Script Adherence  single family dwelling
- E— 6 - c x £ | ﬁ httpfsuigar bbestech.co 27 02:17 68 Script Adherence  homeowners association
— 3" 03:54 56 Scheduling weekend
gl EBCS Tech CRIM gl BBCS Tech CR
= - T i
| SAVEWITHINSULATION.COM = 5
LEON HOLT i Tt ok B il - il B AR - A W o 1 R - )J"IT’ L s & B o 1 p,\ ) [_7
Customer i I
a a a
00:05 / 03:57 b - =

5. From the Select at least one Arbitrator drop-down list, select an arbitrator for the evaluation and

click the plus sign (53). The selected arbitrator is displayed in the text box above the drop-down list.
You can repeat this step to select up to three arbitrators from the drop-down list. When you are
finished selecting arbitrators, click Next.

Note The Arbitrators drop-down list includes only arbitrators who have permission to evaluate the
agent. If the selected arbitrator changes roles/permissions, disputed evaluations can become
stranded. To avoid this problem, you can select more than one arbitrator.

6. The evaluation form appears in the window. The Call Information section displays the names of the
Evaluator, Arbitrator (first and last name if disputed, or "No Dispute" if this is the initial evaluation),
number of score changes, and the agent's name.

7. Review the form to see what items are being evaluated.

8. Use the playback controls to review the audio and/or video content. You can use the playback
controls as needed to pause, fast forward, or rewind the recording to help in your evaluation.
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9. Enter information into the QA form while reviewing the call record.

Note A & appears beside responses that were specified Auto-fail by the form creator.

Note An evaluation’s score appears in the lower-right page corner: Total - 67.00/140.00 (4785 %)

-
Perform QA | Playcal | | Bss || Seve || Submit@AReview |
Call Information =
Reviewer : Administrator Group : East Supervizors Agent Name : PATRICE ACEVEDO
Record : 28006 Call Direction : Cutbound Recording Time : 5/27/2011 8:04:55 PM
Voice Port: 1314 Account Number : Agent Number : 4014
Number Called DNIS © 8389876543 User3: CalleriD ANI :
Channel: 54 Public Bookmark : Duration : 00:03:57

Customer Service Evaluation

Greeting
Did Agent state company name? ™ ves &) No
Did Agent state his/her name? @) ves ©) No
= = -
< 1 | b
Web Player x
__| Screen Capture [ Zoom Panel 5 Tags

e Bl BBCS Tech CRM - Mozilla Firefox # o 8 9 A

o U0 Fle Edit Miew  History  Bookmarks  Tools  Help 01:25 65 | Script Adherence  single family dwe
*

’ 2% 1 02:17 68 | Script Adh h
G M C A et Iﬁ http:/fsugar bt . cnp erence  homeowners ass

3 03:54 | 56 | Scheduling weekend

gl EECS Tech CRM 3 | il BEC:

o S M < ]

PATRICE AC - a1 1 1 ey T LTS R R 'T“WII"'L""“ " y v ﬁ _I
— ' Customer v hJ'IT l : 1 : l’ L ‘Lll_"
00:04 / 03:57 ! : £ |;J
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10. Select a setting for the Send Evaluation to Agent for Acknowledgement? option to indicate if you

11.

12.

want to send the completed evaluation to the agent to review and acknowledge, review and question,
or review and dispute.

Note If the Agent does not have access to the cc: Discover Web Portal, this option is not
available.

Send Evaluation to Agent for Acknowledgement? @yes [ No

Select a priority for the evaluation : Mormal El

Add a Comment:

Select a setting as follows:

= If setto Yes, a text box opens where you can add comments or directions to the agent, and the
evaluation will be sent to the agent for review when the completed evaluation is submitted.

Note If the QA form being used required agent acknowledgment, Yes is the default setting; if
desired, you can change the setting to No.

= If setto No, the completed evaluation will be submitted without being sent to the agent for review.
The evaluation will not appear in the agent's Assignment Inbox or in the Search QA
Acknowledgments results; however, it will appear in the Search QA Evaluations results.

Assign a priority for the evaluation from the drop-down list. The options are Low, Normal, and High,
with Normal being the default.
Do one of the following:

= To save an incomplete QA form to finish later, click Save. The evaluation is saved with a status of
In Progress. In-progress evaluations are not sent to the agent for review.
= If you have completed the QA form, click Submit QA Review.

Messages appear indicating if the evaluation was saved/submitted successfully or requires additional
information. Follow the instructions in the message as necessary. When the evaluation is saved or
submitted, options appear at the top of the page that allow you to modify the completed evaluation or
complete an in-progress evaluation. For details about these options, see Modify or Complete QA
Evaluations. For details about a completed evaluation sent to the agent for acknowledgment, see QA
Review Process.
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Evaluate an Agent

QA forms for evaluating agents’ non-call work are scored on the Coaching tab.

1. Inthe Quality Assurance menu, click Perform QA.
2. The Agent Listing shows all the agents you can evaluate. Double-click the agent to be evaluated.

T L AT

SRl Y WRARN o

3. The Agents Forms Listing shows all the active QA forms attached to groups of which the selected
agent is a member. Double-click the appropriate form.

Note Make sure you select the form with the appropriate Group. Form and Group selections will
affect reporting.

Aigmvn] P Loy Baielh

L0 Sl [ bl [= i
Coanlormr Zorom Eashaton ot Tea
Donpary Tasd Form [T SIS
Dmgiay Tend Form Ol
Dby Tod P Sl P =
Form For Ml LR e

Zaws bt Chesy F

BT Pt e Taam,

4. From the Select at least one Arbitrator drop-down list, select an arbitrator for the evaluation and
click the plus sign (ﬁ?ﬂ). The selected arbitrator is displayed in the text box above the drop-down list.
You can repeat this step to select up to three arbitrators from the drop-down list. When you are
finished selecting arbitrators, click Next.

Note The drop-down list includes only arbitrators who have permission to evaluate the agent. If
the selected arbitrator changes roles/permissions, disputed evaluations can become stranded. To
avoid this problem, you can select more than one arbitrator.
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5. The evaluation form will appear in the window. Enter responses for each question on the form and

notes in the Evaluator Comments field.

Note A L: . appears besides responses that were specified Auto-fail by the form creator.

Note An evaluation’s score appears in the lower right corner of the page.

Perform QA

Record Information
Reviewer . Administrator
Product Knowledge Rewview
Camping Products

Has the agent completed the necessary product usage time?

How many kayak brands can the agent name?

Iz the agent able to demonstrate tent assembly technics?

Sports Products

Can the agent demenstrate archery eguipment?

© ves

Select

I Badk “ Sawve H Submit QA Rewview I

Agent Mame © Smith, Max

® No

Perfecthy ':'Yes, but could be safer. () Mo, is dangerous to self and customers.

Total : 0.00¢ 25.00 (0.00 %)
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6. Select a setting for the Send Evaluation to Agent for Acknowledgement? option to indicate if you
want to send the completed evaluation to the agent to review and acknowledge, review and question,
or review and dispute.

Note If the Agent does not have access to the cc: Discover Web Portal, this option is not
available.

Send Evaluation to Agent for Acknowledgement? @yes [ No

Select a priority for the evaluation : Mormal El

Add a Comment:

Select a setting as follows:

= If setto Yes, a text box opens where you can add comments or directions to the agent, and the
evaluation is sent to the agent for review when the completed evaluation is submitted.

Note If the evaluation used a QA form that required agent acknowledgment, this is the default
setting. If desired, you can change the setting to No.

= If setto No, the completed evaluation is submitted without being sent to the agent for review. The
evaluation will not appear in the agent's Assignment Inbox or in the Search QA Acknowledgments
results; however, it will appear in the Search QA Evaluations results.

7. Assign a priority for the evaluation from the drop-down list. The options are Low, Normal, and High,
with Normal being the default.
8. Do one of the following:

= To save an incomplete QA form to finish later, click Save. The evaluation is saved with a status of
In Progress. In-progress evaluations are not sent to the agent for review.
= If you have completed the QA form, click Submit QA Review.

Messages appear indicating if the evaluation was saved/submitted successfully or requires additional
information. Follow the instructions in the message as necessary. When the evaluation is saved or
submitted, options appear at the top of the page that allow you to modify the completed evaluation or
complete an in-progress evaluation. For details about these options, see Modify or Complete QA
Evaluations. For details about a completed evaluation sent to the agent for acknowledgment, see QA
Review Process.
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Modify or Complete QA Evaluations

After you perform an evaluation on an agent's call record or non-call work, you can perform additional
actions to modify a completed evaluation or complete an in-progress evaluation. To modify or complete
an evaluation, you must first use the Coaching tab to search for the evaluation to be updated.

Accessing an existing completed or in-progress evaluation requires permissions to view QA evaluations.
You can access only evaluations for groups to which you are assigned. Additional permissions are
needed to edit, delete, or complete an existing evaluation.

Note Be aware that if a call is deleted from the server, whether manually or via an archive action, the
QA Evaluations performed on that call will remain in the database for historical searching and review.
Please refer to the cc: Discover Administration Manual for more information on call archiving.

Search for Completed or In-Progress Evaluations

1. Onthe Coaching Tab, in the Quality Assurance menu click Search QA Evaluations.

Search QA Evaluation

=« Save Search Criteria
~ Search Criteria

Form: Agent : Group : Ewvaluator :
Al =l Al =l Al =l Al =l
Start Date : End Date : Q4 Recording ID Recording ID :
i i
QA Score Q4 Status :
Al =l Al ka
Save Criteria Reset Search
QA Record ID Agent QA Form Evaluator Group Name QA Score Call Date QA Start Date QA Completion Date QA Status Call Recording ID
20653 JUAREZ, ERIK Sales Evaluation | Bob Smith Calibration 75 05152012 8142012 an&zmz Completed | 35554
20700 JUAREZ, ERIK Sales Evaluation CEHC.UPY Support Team | 70 05152012 8142012 an&zmz Completed | 35554
Administrator
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Start Date: Pick a starting date as part of a date range. Applies to evaluation date, not the call

End Date: Pick an ending date as part of a date range. Applies to evaluation date, not the call

Recording ID: Find an evaluation for a call based on the call’s record ID number in the system.

Equal to or Less than, Equal to or Greater than. Scores entered in this field may have up to two

2. Enter a combination of search criteria:
= Form: Select a particular form or all forms.
= Agent: Select a particular agent or all agents.
= Group: Select a particular group or all groups.
= Evaluator: Select a particular evaluator or all evaluators.
recording date.
recording date.
= QA Record ID: Number identifying the QA evaluation.
= QA Score: Locate evaluations based on these operators: Equal to, Less than, Greater than,
decimal places and should equal to the percent (%) score desired. For example, if you're
searching for a score of 85.71%, entering 85 in this field with the "Equal to" operator will only
return evaluations with an exact score of 85%.
= QA Status: Choose whether to search for evaluations that are In Progress or Completed, in
Question or Dispute status, or All (default).
3.

Once you have made your appropriate selections, click Search. A list of evaluations matching the

criteria appears in the window. To clear all selected criteria, click Reset. To save this filter, click Save
Criteria. For details about saving custom search filters, see Saveable Search Filters.

Search QA Evaluation

- Save Search Criteria

Name Default Type Creator Date Created Actions
Jane Public sUperuser 41292013 Apply Delete
John Doe X Private sUperuser 41292013 Apply Delete
Reggie Private sUperuser 41292013 Apply Delete
~ Search Criteria
Form: Agent : Group : Ewvaluator :
Al =l Al =l Al =l Al =l
Start Date : End Date : Q4 Recording ID : Recording ID :
| |
QA Score QA Status :
Al =l Al =l
Save Criteria Reset Search
QA Record ID Agent QA Form Evaluator Group Name QA Score Call Date QA Start Date QA Completion Date QA Status Call Recording ID
20653 JUAREZ, ERIK Sales Evaluation | Bob Smith Calibration 75 05152012 8142012 aM&iz0z2 Completed | 356554
20700 JUAREZ, ERIK Sales Evaluation Call;u P}f Support Team | 70 05152012 8142012 aM&iz0z2 Completed | 356554
Administrator
8505 FLETCHER, TINA Eﬂ:};::;;semce Sue Smith Johns Team | 122 05152012 81472012 81412012 Completed | 15220
115 WINTERS, LARRY Eﬂ:};::;;semce John Doe Support Team | 93 05152012 81472012 81412012 Completed | 2018
1118 WINTERS, LARRY Sales Evaluation | Sue Smith Calibration 55 05152012 8142012 aM&iz0z2 Completed | 2018
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4. To access a particular completed or in-progress evaluation, double-click it. The evaluation opens in
the window.

Perform QA | PlayCall || Printable Version | | Deletethe Completed QA ||  Edit the Completed QA || Back |
Call Information
Reviewer : John Doe ACD Group © East Supervisors Agent Name : JOY BAILLEY ACD Queue :
539
Record : 3254 Call Direction : Inbound Recording Time E::IZMU 52223 Screen Capture : Yes
Phone Mumber : 1207 User 1 Agent Humber : 4020 Project
Number Called (DNIS) : 86862758925 User 3 Callerly (ANI) © 2123793946 User 4:
Channel : 68 User5 Duration (Sec) : 00:08:11
Sales Evaluation
Greeting
Did Agent use branded greeting? @ yves CNg
Did the Agent state his/her name? @ ves CINg
Did the agent verify the promo code? @ves DNo
Agent should validste code against screen pop
Sales Skills
Was sale closed? @ves Do
What objections were given? Price El
DNone
How many rebuttals were used? 1
@z
Not bad, but we will need to work on your documentation -
Notes / Tips
Documentation
‘Was proper closing code used? @rves TN
Were notes concise and professional? Good Iz‘
Total : 70, 3 %)
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Modify or Complete QA Evaluations

When searching for evaluations, custom search filters can be built and saved so users do not need to
enter criteria every time they want to conduct a search.

To save a custom filter, select the necessary criteria, then click Save Criteria. A dialog will prompt for a
name for the filter, whether access to the filter is public or private, whether this should be set as the user's
default filter, and whether the filter should be saved over the currently applied filter or as a new filter. An
existing filter can be used to create a new entry by applying the entry and changing the search values.
Then click Save Criteria to save a new entry. If the old entry is hot needed, it can be deleted.

Private filters may only be viewed, edited, and deleted by the user who created them. Public filters may
be viewed by all users with permissions to search for QA evaluations, but can only be edited or deleted
by the user who created them. The current default filter is denoted in the list of saved filters by an X in its
row under the default column. The default filter will load automatically when this page opens. If a default
filter is set and it's necessary to search without filtering results or to start building a new set of criteria,
click Reset. The default filter is overridden when viewing QA evaluations directly from the Web Player

Call List.

To apply a filter from the list, click Apply. To remove a filter from the system, click Delete.

Search QA Evaluation

~ Save Search Criteria

Name
Jane
John Doe

Reggie

~ Search Criteria
Form :
All
Start Date :
852z
QA Score :

All

Default

Agent:
j Doe, Jane
End Date :
o 9rsiz012
04 Status
=l Al

Type
Public
Private
Private
Group :
4 Al
Record ID :
|
[
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Date Created

4282013

Creator Actions

Apply Delete
Apply Delete
Apply Delete

SUPETUSEr
SUpPEruser 4292013

sSUpEruser 412972013

Evaluator

4 Al 4

Recording ID :

| Save Criteria J | Reset I Search |
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Additional Functions

After you have searched for and opened a completed or in-progress evaluation, additional options are
available to allow you to perform several actions on the evaluation. Some of these options require added
Coaching permissions in addition to permission to view QA evaluations.

Perform QA | Play Call I Link For Completed QA il Printakle Version I Delete this QA I Edit this Q& /1 Badk |

32

Play Call: Plays the call for which this particular evaluation was completed.

Link for Completed QA: Displays the URL of an evaluation in a popup window. This option is useful
if referencing a completed QA in an email.

Printable Version: Opens the evaluation in PDF format that you can then save or print. The printable
PDF includes the fields Agent, Evaluator, Arbitrator, Evaluation Form, Date of Evaluation, Date of
Recording, and Call ID.

Delete this QA: Deletes the evaluation from the system. You will be prompted to enter a reason for
the deletion and confirm the deletion request.

Note If more than one user opens the same completed or in-progress evaluation
The following permissions are required:

= Permission to allow deletion of completed evaluations. Very few users should be given this
permission. This permission does not apply to in-progress evaluations.

= Permission to allow performing of evaluations. This permission is required for editing and deleting
of in-progress evaluations but is not needed for deletion of completed evaluations.

Edit this QA: Allows you to update a completed evaluation or complete an in-progress evaluation, as
follows:

= For a completed evaluation, make any necessary updates and click Submit QA Review. The
original version of the evaluation is not retained in the system. Requires permission to allow
editing of completed evaluations.

= For an in-progress evaluation, you can make all changes needed to complete and submit the
evaluation or you can make some changes and save the evaluation to complete later. To submit
the completed evaluation, click Submit QA Review. To save the incomplete evaluation to finish
later, click Save. Requires permission to allow performing of evaluations.

Note Deleting or editing completed QA forms affects reporting.
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QA Acknowledgments

If, during your evaluation of agents, you require them to acknowledge their completed forms, they will
review and acknowledge the evaluation on the cc: Discover Home tab. (See the cc: Discover Web Player
Manual for additional information.)

To determine which agents have acknowledged their evaluations, you can perform a search from the
Coaching tab. In the Quality Assurance menu, click Search QA Acknowledgments.

| Home | webPiayer | coaching | Reporting | Surveys | Administration Logged in as superuser | Change Password | Logout

Quality Assurance Search QA Acknowledgments Search
Create Form QA Form: Agent. Group:
e &l Bl g
Search QA Evaluations Evaluator Arbitrator: Start Date: End Date:
Al [=] an [] | osn01:2013 = 11/26/2013 =
Acknowledgment Required Evaluation/Acknowledgment Status:
Al [=] an [=]

Agent Name QA Form Evaluator Arbitrator Group Evaluation Date Acknowledgment Date Status Acknowledgment Required

Doe, John Sales Evaluation Smith, Jane NiA Team A 9/10/2013 NIA Unacknowledged | Yes

The Search QA Acknowledgments page allows you to search for a completed evaluation using a
combination of search criteria:

e Form: Allows you to select a particular form or all forms.

e Agent: Allows you to select a particular agent or all agents.

e Group: Allows you to select a particular group or all groups.

e Evaluator: Allows you to select a particular evaluator or all evaluators.

e Start Date: Allows you to pick a starting Evaluation Date range. The start date will automatically
default to a week prior to today’s date.

e End Date: Allows you to pick an ending Evaluation Date range. The end date will automatically
default to today’s date.

e Acknowledgment Required: Allows you to search for evaluations based on whether the QA form
creator required agent acknowledgment. The search finds only evaluations where the evaluator
selected to send the evaluation to the agent for acknowledgment.

» |[f setto “Yes,” finds evaluations where the QA form required agent acknowledgment and the
evaluation was also sent to an agent for acknowledgment.

= If set to “No,” finds evaluations where the QA form did not require an acknowledgment but the
evaluation was sent to an agent for acknowledgment.

= |f set to “All,” finds all evaluations sent to an agent for acknowledgment, regardless of whether the
QA form required agent acknowledgment.

e Evaluation/Acknowledgment Status: Allows you to search for evaluations with a status of
Acknowledged, Unacknowledged, Question, or Dispute.

Click Search to generate a list of acknowledged or unacknowledged evaluations, based on your selection
criteria. The results display only groups and agents with the same roles as the logged-in user.
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QA Review Process

After a QA evaluation has been completed for an agent, the agent receives an email notification or sees
the envelope icon at the top of the Web Portal, and can do three things: review and acknowledge, review
and question, or review and dispute. Agents have the option to question or dispute QA evaluations if they
disagree with or need clarification on the score received. QA evaluations awaiting review appear in a
user's New Assignments section under the Home Tab > Assignment Inbox. QA Evaluations are denoted
by a check in the box in the Type column. The New Assignments, Pending Assignments, and Reviewed
Assignments sections are explained in greater detail in the cc: Discover Web Player Manual's "Web
Portal Basics > Home Tab" section.

Note The Agent/Evaluator/Arbitrator Comments fields:

e Are limited to 1500 characters (including spaces) per field.
e Allow percent signs (%), parentheses, hyphens, commas, and periods, but no other special
characters.
If either of these limitations is violated, when the form is submitted, an error message will appear.
These comments also appear when an evaluation is converted to a PDF for printing. When an
evaluation is in acknowledged, question, or dispute status, agents cannot interact with any buttons on
the evaluation or add additional questions or comments.

Acknowledge an Evaluation

This is the most common interaction. A user accepts the score and information provided in the evaluation
by clicking Acknowledge. This moves it to the Reviewed Assignments section.

1. Incc: Discover, an agent clicks Home tab > Assignment Inbox > New Assignments to view the list of
evaluations and documents awaiting attention.

2. The agent clicks an evaluation to open it.

3. After reviewing the evaluation, the agent can acknowledge the evaluation two different but equivalent
ways:

= Enter comments in the Agent Comments field and click Acknowledge to agree with the
evaluation score and evaluator’'s comments.
= Click Back and then click Done next to the item in the New Assignments list.

4. The evaluation is moved to the agent's Reviewed Assignments section.

5. The evaluator can now search for the evaluation on the Coaching tab by using the Search QA
Acknowledgments menu. The status of the evaluation is "Acknowledged" and Acknowledgment Date
is the current date.
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Question an Evaluation

If an agent has a question about an evaluation — anything from why they received the given score to
seeking clarification on the evaluator's comments — they can utilize the Question function to
communicate with the evaluator.

1.

In cc: Discover, an agent clicks Home tab > Assignment Inbox > New Assignments to view the list of
evaluations and documents awaiting attention.

The agent clicks an evaluation to open it.

After reviewing the evaluation, the agent enters a question in the Agent Comments text field
(required) and clicks Question.

The evaluation moves to the agent's Pending Assignments section with a status of "Question."

The evaluator can now search for and open the evaluation on the Coaching tab by using the Search
QA Acknowledgments menu.

In the open evaluation, the evaluator clicks Edit this QA and responds to the agent’s questions by
adding comments in the Evaluator Comments text field.

The evaluator clicks Submit QA Review.

The updated evaluation moves to the agent's New Assignments section on the Home tab, and the
system sends an email notification to the agent about the response. The envelope icon appears at
the top of the web portal.

The agent reviews the evaluator’'s comments and performs one of the following actions:

= Acknowledge: The agent enters comments if necessary and clicks Acknowledge.

= Question: If the agent has additional questions, those questions are entered in the Agent
Comments field and the agent clicks Question.

= Dispute: If the agent disagrees with the evaluation, comments are entered in the Agent
Comments field and the agent clicks Dispute.

An evaluation can be questioned and moved back and forth between the agent and the evaluator an
unlimited number of times until a satisfactory resolution is reached. All comments are retained on the
evaluation throughout this process.
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Dispute an Evaluation

If an agent disagrees with the score given to an evaluation, they can utilize the Dispute function to
communicate with up to three dispute arbitrators. If an evaluation is in dispute status, only an arbitrator
can edit it. If more than one arbitrator is assigned to an evaluation, the first arbitrator to open and view
(even if not editing or rescoring) the evaluation is designated as the arbitrator for that evaluation. Any
attempts by other arbitrators to make changes after that will display a message indicating another
arbitrator has already rescored the evaluation and that no new changes have or can be saved.

1.

10.

11.

In cc: Discover, an agent clicks Home tab > Assignment Inbox > New Assignments to view the list of
evaluations and documents awaiting attention.

The agent clicks an evaluation to open it.

After reviewing the evaluation, the agent enters a comment in the Agent Comments text field
(required), then clicks Dispute.

The evaluation moves to the agent's Pending Assignments section with a status of "Dispute."”

The system sends an email to each of the arbitrators (persons selected to review disputed
evaluations) notifying them that an evaluation is being disputed.

An arbitrator can now search for and open the evaluation on the Coaching tab by using the Search
QA Acknowledgments menu.

Note The original evaluator can see that the evaluation is being disputed, but cannot change
anything on the evaluation unless they are specified as an arbitrator for that evaluation.

In the open evaluation, the arbitrator clicks Edit this QA, re-scores the evaluation, and responds to
the agent’'s comments by adding comments in the Arbitrator Comments text field.

The arbitrator clicks Submit QA Review.

The updated evaluation moves to the agent's New Assignments section on the Home tab, and the
system sends an email notification to the agent about the response. The envelope icon appears at
the top of the web portal.

The evaluator or arbitrator can now search for the evaluation with a status of "Unacknowledged," and
the arbitrator's name now appears on the evaluation form.

The agent reviews the arbitrator's comments and performs one of the following actions:

= Acknowledge: The agent enters comments if necessary and clicks Acknowledge.

= Question: If the agent has additional questions, those questions are entered in the Agent
Comments field and the agent clicks Question.

= Dispute: If the agent disagrees with the evaluation, comments are entered in the Agent
Comments field and the agent clicks Dispute.

An evaluation can be disputed and moved back and forth between the agent and the arbitrator an
unlimited number of times until a satisfactory resolution is reached. All comments are retained on the
evaluation throughout this process.
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Content Library

The Content Library enables users to upload files that can be shared with agents who have access to the
cc: Discover Home tab. Files that can be uploaded include Word files, PDFs, Web pages, QA evaluations,
and calls exported from cc: Discover.

See the cc: Discover Web Player Manual for how to use the Home tab.

Tip Distribute the cc: Discover manuals to the appropriate users via the Content Library. Doing this
ensures that users always have access to the manuals when they are in the application, and it can
reduce the number of questions to system administrators. Separate categories can be created for
different types of users, such as Help for agents or supervisors and Admin Help for system
administrators.

The Content Library appears on the Coaching tab. Documents are organized into Content Categories.
The number of items in each category appears inside the parenthesis to the right of the name. Click on a
category to display the documents in that category.

l Home | Web Player | Coaching 1 Reporting | Administration <LifEL LIEELlelfE | LIELIE IEELLL || STITL

Quality Assurance Category :
Title Assigned Date Type Size Assigned by Assigned Categories Actions
Content Library

Edit
Customer Service (3) CallCopy-Fax Cover.dobe 2182010 ] 30000 Administrator Customer Service L—J
HR (2) Delete

Sales (6) Edit
Uncategorized (2] cchiscover Web Player Guide, v4.3.docx ro2o10 | | 1852000 Administrator Custemer Service
Delete
— Edit
Group QA Summary 5172010 iﬁl_] 26624 Adminigtrator Custemer Service, Sales —
Delete

Pages: 1 GoToPage: 1  of1 |@|

For each document, the following information is displayed:

e Title: The name of the file.

e Assigned Date: The date the content was uploaded and assigned.

e Type: Displays graphically the file type (Word, Excel, Power Point, etc.).

e Size: The size of the document/content.

e Assigned By: The user who uploaded and assigned the content.

e Assigned Categories: All of the categories that this document/content is assigned to

e Actions: Edit allows you to change content assignments. Delete removes the content from the
library.

Note Deleting items from the Content Library removes the entry on the Web Portal but not the
uploaded content file on the CallCopy server. To help with disk space management issues, you
may want to inform your system administrator when you delete items from the Content Library.

Content can be accessed by double-clicking the title of the content/document. You will be prompted to
Open or Save the file.
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Manage Categories

Content Categories allow the user to organize and assign library content.

. Home | Web Player | Coaching1 Reporting I Administration Logged in as superuser | Change Password | Logout

Quality Assurance Content Categories | Mew || Deets | | Save |
Categories : Details :
Content Library .
Customer Service (3)
HR (2} .
Manage Content Sales (8) Title :
Add Content Uncategorized (2} Parent category :  Root El
Content Categories

Agent Lis
Agent Group List
Acknowledgments Report

To create a new Category, on the Coaching tab, in the Manage Content menu, click Content Categories.
In the Details section, enter a name for the category in the Title field. In the Parent Category list, select an

existing category if you would like the new Category to become a child of it. Otherwise, select the Root
option from this list.

To delete a category, select it from the Categories list, and click Delete.

To edit a category, select it from the Categories list. Edit the title or parent category and click Save.

Add Content

Follow these steps to add content into the library:

1. On the Coaching tab, click the Manage Content menu and then click Add Content. The Add Content
page is displayed:

Web Player Coaching Reporting Administration Logged in as superuser | Change Password | Logout

Quality Assurance Add Content

Content Library Flease select a file to upload :

Manage Content
Upload Fi
Add Content Upload File
ontent Categories
Agent List

Agent Group List
Acknowledgments Report

2. Click Browse and navigate to the file you want to upload into the library.
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3. Once your file is populated in the upload field, click Upload File. Additional fields are displayed,
where you can specify details about the uploaded file.
4. Complete the following information:

= Title: The name displayed in the Content Library for the file. This field defaults to the filename of
the uploaded file. You can edit this field to change the name.

= Priority: Agents see this value when they see the content on the Home tab. If agents have
multiple items to review, this value communicates the importance of this item.

= Duration: An estimate of how long it takes to review a document.

= Unassigned/Assigned Categories: Indicates the categories in which the file will appear in the
Content Library. Select one or more categories from the Unassigned Categories list, and click the
arrow to move them to the Assigned Categories list. If no category is selected, the file appears in
the Uncategorized list in the Content Library.

= Unassigned/Assigned Groups: Indicates which CallCopy groups have permissions to view the
file in the Content Library on the Coaching tab and in the New Assignments list on the Home tab.

File type and File size are identified by the system and cannot be changed.

Add Content Back Save
Title : Priority : Duration (HH:MM:55) :
Federal Sales Training Guide 2011.docx Low * 00 - 00 - 00
File Type File Size :
L| application/octet-stream 9.73 kb
Unassigned Categories : Assigned Categories :
Uncategorized Federal Sales

HR Resources
Customer Service
Sales

Unassigned Groups : Assigned Groups :

Calibration
ClientaBC
Client:(vZ
Janes Team
Johns Team
Sales Team
Support Team

5. Click Save. A confirmation message appears if the save was successful. An email is sent to users in
the assigned groups. An envelope icon appears at the top of the Web Portal when the user logs into
cc: Discover.
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Agent List/Agent Group List

The Agent List shows each agent, the number of groups to which he belongs, and the number of
documents assigned to the agent. The Agent Group List shows each CallCopy group to which agents can
be assigned and the number of agents in that group.

This information may be useful for tracking the total docs assigned to an agent who is part of multiple
groups or if loading multiple documents for a group.

Acknowledgments Report

If you have assigned content to an agent, you can report on who has or has not reviewed/acknowledged
that assigned content. Go to the Acknowledgments Report link under the Coaching tab, in the Manage
Content area.

I Home I Web Player | Coaching 1 Reporting Surveys Administration EE | Logged in as superuser | Change Password | Logout

Quality Assurance Search Acknowledgments Search
Content Lib
e Form:| All [=] Category : | All [=] Group :| Al [=]
Manage Content Agent:| All =] Status ;| All =
Add Content Dale Type - | Assigned Date [x] StaiDate 1/42012 =] End Dale - | 1/4/2012 il
Content Categories
Agent List
Agent Group List Agent Name Content Title Assigned Date Due Date Review Date Priority Type Size Assigned by Categories Reviewed
Acknowledgments Report Anderson, Brad  cc Discover Web Player 5 Tips.docx 11412012 142012 MotReviewed Normal | |pocx 10372 Administraler  Hinls &Tips Mo
Barsa, George ce Discover Web Player 5 Tips docx 1/4/2012 14472012 Mot Reviewed — Marmal __lpocx 10372 Administrator Hints & Tips ~ No
Eddy, Cheryl cc Discover Web Player 5 Tips.docx 1/4/2012 1/4/2012 Mot Reviewed Mormal _pocx 10372 Administrator Hints & Tips No
. Administrator cc Discover Web Player 5 Tips.docx 1/4/2012 14472012 10412012 Normal __pocx 10372 Administrator Hints & Tips ~ Yes
Pages 1 GoToPage: |t off |E\

This will allow you to search for acknowledgments of completed assignments using a combination of
search criteria:

e Form: Allows you to select a particular piece of content or all content.

e Category: Allows you to select a particular category or all categories.

e Group: Allows you to select a particular CallCopy group or all groups.

e Agent: Allows you to select a particular agent or all agents.

e Reviewed Status: Allows you to select all statues, pending status, or reviewed status.

e Date Type: Allows you to select from the Assigned Date, which is the date the content was uploaded.

e Start Date: Allows you to pick a starting date range. The start date will automatically default to
today’s date.

¢ End Date: Allows you to pick an ending date range. The end date will automatically default to today’s
date.

L . Search
Once you have selected criteria, click |_>earch ) to generate your report.
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Manage Achievements

About Achievements

cc: Discover provides the ability to establish a system for awarding points to agents who have achieved
certain pre-defined goals. Identifying and rewarding clearly defined goals can lead to improved agent
performance and productivity, as well as creating a positive way to promote competition among agents.

In cc: Discover, the Achievements functionality allows you to:

e Create custom achievements that can be awarded to individual agents or particular CallCopy groups.

e Award points based on an agent's performance on QA evaluations or other goals defined by your
organization.

e Track achievements that have been awarded, along with the total points awarded to each agent.

e Set a date when an achievement can no longer be awarded or when its points expire.

e Automatically notify agents about their own achievements as well as achievements awarded to other
agents.

Achievement Types

Accomplishments to be awarded are created in cc: Discover as achievement types. Achievement types
can be:

e Based on QA evaluation scores. These achievements are awarded automatically by the system as
soon as an agent receives the required score on the specified number of QA evaluations.

o Defined ad hoc according to your organization's needs. Ad hoc achievements are awarded manually
when an agent or CallCopy group accomplishes a pre-defined goal. These goals can be based on
any factors or behavior your organization wants to reward, such as survey results, customer
feedback, attendance, average handle time, or script adherence.

Each achievement type must specify the number of points to be awarded and the individual agents or
CallCopy groups eligible to receive the achievement award. An achievement type can also have specific
start and end dates that indicate when the achievement can be awarded. Points can be set up to expire in
a specified number of days after being awarded or by an expiration date. Expired points are automatically
removed from an agent's total point count.
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Notification of Achievement Awards
When agents are awarded achievement points, either by meeting the scoring criteria for evaluations or by
receiving an ad hoc achievement award, they can be notified by any of the following notification methods:

e Emall
e News widget
e Achievement widget

Each achievement type must be set up with one or more of these notification methods.

Email Notification

When an agent is notified by email that an achievement was awarded, the email includes the following
text:

Email subject: Congratulations on Your Achievement!
Email body text:

You have been awarded this achievement:

Name: <achievement type name>

Points: <number of points awarded for this achievement>
Expiration: <expiration date for points>

To receive an email notification, agents must have an email address specified in their cc: Discover user
account.

Widgets

The Achievement widget is automatically available to be added to a user's dashboard on the Home tab.
With this widget, agents can view information about achievements awarded to them as well as to other
agents. Managers and supervisors, as well as agents, can also use this widget to view a list of high-
scoring agents and newly added achievement types.

The News widget displays a posting to all users each time an achievement is awarded. The text of this
posting is: <agent name> received a <achievement type name> achievement.

For more details about the information displayed on these widgets, see the cc: Discover Widget
Administration Manual.

Achievement Icons

Achievement awards can be represented with an icon image that is displayed when the achievement
appears in the Achievement widget. The following five standard icons are preloaded in cc: Discover and
are available to be selected when the achievement type is added or edited:

RAANY RS RERTY
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Custom icons can also be loaded to use instead of one of the standard icons. Custom icons have the
following format requirements:

e File size: 105 x 105 pixels
o File type: PNG

Guidelines for Awarding Achievements

When awarding achievements, the following guidelines apply:
e For achievements based on QA evaluation scores:

= Achievements cannot be awarded for QA evaluations performed in the past.

= A QA-based achievement cannot be awarded multiple times for the same evaluation. If an
evaluation is re-scored, the achievement is not awarded even if the new score qualifies for an
achievement.

= Changes to a QA evaluation form do not affect achievements that have already been awarded.

e For ad hoc achievements:

= The same achievement type can be awarded more than once to the same agents or CallCopy
groups, until the achievement end date is reached.

= If an achievement is awarded to multiple CallCopy groups and an agent belongs to more than
one of those groups, the agent is awarded the achievement only once.

= You may want to base ad hoc awards on metrics obtained from cc:Discover reports, such as
agent ranking, script adherence, average handle time, or improvement in evaluation scores.

User Permissions

To perform activities related to setting up an achievement award system, users must have been
administered with the correct Coaching permissions. These activities include adding or editing an
achievement type, awarding an ad hoc achievement, viewing or deleting awarded achievements, and
uploading custom icons.

Depending on how your permissions are set, some of the achievement menus may not display. For
assistance, contact your system administrator.
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Add an Achievement Type

Before you can add an achievement type, you must have the Allow Manage Achievements Coaching
permission. For assistance, contact your system administrator.

To add an achievement type, follow these steps:

1. On the Coaching tab, click the Achievements menu and then click Achievement Types.

Home | Web Player | Coacmng1 Reporting | Surveys | Administration = Logged in as superuser | Change Password | Logout

Quality Assurance Achievement Types Add Mew Achievement Type
Name Description Icon Points Published Date Start Date End Date Action

Content Library

Manage Content

No Records Found

Achievements

Achievement Types
Upload lcon = I T Displaying items 0 - 0 of 0

Award an Achievement
Awarded Achievements

2. Click Add New Achievement Type. The Achievement Type page is displayed.

Achievement Type [ Cancel H Save J
Name: it
Description: N
Start Date:
End Date:

3. Enter the following information:

= Name: The name of the achievement to be awarded. This is the display name used if the
achievement is posted to the agent's email or widgets.
= Description: A description of the achievement, up to 150 characters. This description is not

displayed to agents. This field is optional.
» Start Date: The first date that this achievement type can be awarded, either automatically or ad

hoc. This date must be today's date or later.
» End Date: The last date that this achievement type can be awarded. If no date is specified, the

achievement is open-ended.
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4. Specify the CallCopy groups or specific agents eligible to be awarded this achievement, as follows:

Award to Either:

i@ CallCopy group
i) Agent

Select to add: All | Hone Select to remove: All | Hone

[ Groupni I
[7] Groupnz
|:| Group03 :
|:| Groupl4
"Remove

|:| Groupl5s

a. Select one of the following options:

e CallCopy group: Allows you to select one or more groups from a list of all available groups.
e Agent: Allows you to select one or more agents from a list of all active agents.

b. Depending on the option selected above, select one or more agents or groups by clicking its
check box (or click All to select all possible agents or groups), and click Add.
Note When an ad hoc achievement is manually awarded, users will be able to award only the
agents or groups they have permission to access.

5. For Criteria, select one of the following:

Ad hoc: Indicates that the achievement can be manually awarded ad hoc. This is the default
value. Skip to step 7.
= QA: Indicates that the achievement can be awarded automatically based on the agent's QA

evaluation scores. When you select this option, additional fields display that allow you to define
the scoring criteria. Go to the next step.

Criteria:
QA [~]
This achievement is awarded to agents who have

Number of evaluation:
1

Evaluation form:

Score:
Les= Than El Yo
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10.

11.
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Complete the following criteria required for the achievement to be awarded based on QA evaluation
scores:

= Number of evaluation: Enter the number of evaluations, from 1 to 999, for which the agent must
receive the specified score in order to be awarded the achievement. The default value is 1.

= Evaluation form: Specify the QA evaluation form used to score the evaluations. You can select
from a list of active QA forms assigned to the agents or groups previously selected.

Note If this list is blank, one or more of the selected agents or groups were not assigned to a
QA form.

= Score: Indicate the score the agent must receive on the specified number of evaluations to be
awarded the achievement, as follows:

e Enter the score as a percentage (whole numbers only).
e Indicate if the score received must be less than, equal to, greater than, less than or equal to,
or greater than or equal to the specified percentage score.
Note You cannot add more than one achievement type for the same agents or CallCopy group, using
the same QA form, that has overlapping start and end dates.

For Points, type the number of points to be awarded for the achievement. You must enter a number
from 0 to 999.

For Points Expiration, if desired, you can indicate when the points for this achievement will expire
and be removed from the agent's total points. This option applies only if an end date was specified for
this achievement type. Select one of the following:

= Date: Select a date on or after End Date.
= Number of days: Type the number of days after the achievement is awarded that the points will
expire.

If desired, you can change the icon displayed when the agent is notified about the achievement
award, as follows:

a. Click the icon currently displayed. A popup opens with all available icons, including any custom
icons previously uploaded.

b. Click the desired icon.

c. Click OK.

For Post To, select the notification method for informing agents that this achievement type was

awarded. You must select one or more of the following methods:

*  Emalil
= News widget
= Achievement widget

Click Save.

The Achievement Types page is displayed, listing the new achievement type, and the achievement is
now available to be awarded. Achievements based on QA evaluation scores are awarded
automatically when the agent completes the required number of evaluations that meet the scoring
criteria. Ad hoc achievements can be awarded manually after the start date for the achievement is
reached.
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View or Edit Existing Achievement Types

Before you can view or edit existing achievement type, you must have the Allow Manage Achievements
Coaching permission. For assistance, contact your system administrator.

To view or edit existing achievement types, follow these steps:

1. On the Coaching tab, click the Achievements menu and then click Achievement Types. A list of all
added achievement types is displayed.

B | Logged s superuser | Change Password | Logout

Home | Web Player I Cmchlng1 Reporting I Surveys | Administration

Quality Assurance Achievement Types Add New Achievement Type
Content Library Name = Description Icon Points Published Dat Start Date End Date Action
High Scores for the Month Awarded to agents who score at least 90% on 2 evaluations for the month. | ¥ ] 10 10/21/2013 10172013 1173002013 Edit
Manage Content
Correctly Used New Greeting Proto The agent correctly used the new company greeting Bd s 100182013 10182013 1HB2013 Edit

Achievements

S
Achievement Types R 1
Upload lcon

Award an Achievement
Awarded Achievements

Displaying items 1 - 2 of 2

2. For each achievement type listed, you can view the following summary information:

= Name: The name given the achievement when it was added.

= Description: The description, if any, given the achievement when it was added.

= Icon: The icon displayed when the agent is notified of the awarded achievement by widget.

= Points: The number of points the agent receives when the achievement is awarded.

= Published Date: The date the achievement type was added. If the achievement type is edited,

this date is updated.
= Start Date: The first date that this achievement type can be awarded, either automatically or ad

hoc.
= End Date: The last date that this achievement type can be awarded, either automatically or ad

hoc.

3. To edit the achievement type, click Edit. You can update any of the achievement type fields, even if
this achievement has already been awarded to agents. Whenever you edit an achievement, you must
change the start date to be today or later and the end date, if any, to be after the start date. When you
are done making changes, click Save.

Note Use caution when editing achievement types. If an agent receives the same ad hoc
achievement award more than once, it may be confusing if details such as the number of points
awarded or the expiration date have changed. Edits to an achievement type do not affect
achievements that have already been awarded.
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Upload a Custom Icon

Before you can upload a custom icon:
You must have created the .PNG file containing the icon image in a location you can access. The file

size is restricted to 105 x 105 pixels.
You must have the Allow Manage Achievements Coaching permission. For assistance, contact

[ ]
your system administrator.

To upload a custom icon, follow these steps:
1. On the Coaching tab, click the Achievements menu and then click Upload Icon.

= Logged in as superuser | Change Password | Logout

Vieb Player Coaching Reporting Surveys Administration

Cancel OK

Quality Assurance Upload leon

Icon file must be PNG format and 1052105 pixel.

Content Library
Name:

Manage Content

Achievements searchiupload from your own desktop:

Achievement Types Erowse

Upload lcon

Award an Achievement
Awarded Achievements

2. For Name, type a name for the icon.

Click Browse and select the file to be uploaded.
Click OK. The custom icon is now available to be selected when adding or editing an achievement

w

type.
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Before you can award an ad hoc achievement:

Manage Achievements

e An achievement type for this award must have been added, where Start Date is today or later and

End Date has not been reached. For details, see Add an Achievement Type.

e You must have the Allow Award Ad Hoc Achievements Coaching permission and have access to
the agents or groups receiving the achievement award. For assistance, contact your system

administrator.

To award an ad hoc achievement, follow these steps:

1. Onthe Coaching tab, click the Achievements menu and then click Award an Achievement.

Home Web Player Coaching Reporting Surveys Administration

Quality Assurance Award An Achievement

Content Library Select an achievement type:

Manage Content

Achievements

Achievement Types
Upload lcon

[ﬁwarﬁ an Achievement

Awarded Achievements

2. From the drop-down list, select the achievement type that you want to award.

Note The name of each achievement type includes a label (Agent Type or Group Type) indicating
whether the achievement can be awarded to individual agents or groups of agents.

A list of agents or groups eligible for the achievement award is displayed. This list includes only

agents and groups that you have permission to access.

Select an achievement type:

Correctly Used New Greeting Protocol (Group Type)

Select to add: All| None Select to remowve: All] Hone

|:| Group01

e
—

[=]

3. Select one or more agents or groups by clicking its check box (or click All to select all possible agents

or groups), and click Add.
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4. Click OK. You are prompted to confirm that you want to award the achievement to the specified
agents or groups.

The achievement is awarded immediately to the specified agents or groups, and the list of agents
awarded this achievement is displayed on the Awarded Achievements page on the Coaching tab.
Agents receiving the award are notified depending on the type of notification (email, News widget,
Achievements widget) allowed for this achievement type.
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Awarded Achievements

After achievements have been awarded to agents, either ad hoc or automatically based on QA evaluation
scores, you can display detailed information about all awarded achievements using the Awarded
Achievements page.

Note To view or delete awarded achievements, you must have the Allow Manage Achievements
Coaching permissions. For assistance, contact your system administrator.

You can use the Awarded Achievements page to:

e Search for agents who were awarded achievements, based on the agent's CallCopy groups, the date
the achievement was awarded, the agent's status, and whether the achievements have expired
points.

e View the total number of points currently awarded to an agent.

o View achievements for agents who have become inactive after being awarded points.

e View a list of all achievements awarded to a particular agent.

¢ View summary information about each awarded achievement, such as the date the achievement was
awarded and the date an achievement's points will expire.

o Delete the points awarded for an achievement from an agent's total points.

Note CallCopy groups are displayed on the Awarded Achievements page with the name of the group in
cc:Discover at the time the achievement was awarded. If this name is changed after the achievement is
awarded, be aware that the achievement is still displayed with the old group name.

Search for Agents with Awarded Achievements

1. Onthe Coaching tab, click the Achievements menu and then click Awarded Achievements.

The Awarded Achievements page is displayed, listing all agents who were awarded achievements.

Home | Web Player I Coaching 1 Reporting | Surveys | Administration = Logged in as superuser | Change Password | Logout|
Quality Assurance Awarded Achievements Search
Content Library Group: All | None Agent: All | Hone Agent Status:

- - -
Manage Content Awarded Start Date: Awarded End Date: Points Expiration:
[ [ -
Achievements
Achievement Types
Upload Icon Agent Agent Status CallCopy Group Total Points Action
Award an Achievement
dwarded Achievements Cunningham, Richard Active Group02 7 View Details
Flanders, John Active Group03 3 View Details
Brooker, Anders Active Groupl1 5 View Details
Barnes, Phil Active Group01 10 View Details
Burke, Keith Active Group01 10 View Details
Francis, Connie Active Group03 3 View Details
Emerson, Andy Active Group03 3 View Details

cc: Discover QA Coaching Manual, v5.3 51



Manage Achievements

2. You can filter the list to search for specific agents, using a combination of search criteria:

Group: Along with the Agent filter, allows you to select which agents are included in the search
results. You can select one or more groups, which restricts the Agent drop-down list to include
only agents in those groups. You can further filter the search results by selecting specific agents.
If you do not filter by agent, all the agents in the selected groups are included in the search
results. To select all groups in the drop-down list, click All; to clear the selected items, click None.
Agent: Along with the Group filter, allows you to select which agents are included in the search
results. You can select one or more agents, depending on the groups previously selected. If no
groups were selected, you can select from a list of all agents. If groups were selected, you can
select only agents included in those groups. To select all agents in the drop-down list, click All; to
clear the selected items, click None.

Note Make your group selections before selecting agents. If you select agents and then
select groups, the selected agents are cleared.

Agent Status: Allows you to indicate if the search results include agents who are active, inactive,
or both. The default is both (field left blank).

Awarded Start Date: Allows you to select a starting date as part of a range of dates. Agents who
were awarded achievements within the specified date range are included in the search results. If
you select a starting date for the range but no ending date, the search results include agents
awarded achievements on or after the starting date.

Awarded End Date: Allows you to select an ending date as part of a range of dates. Agents who
were awarded achievements within the specified date range are included in the search results. If
you select an ending date for the range but no starting date, the search results include agents
awarded achievements on or previous to the ending date.

Points Expiration: Allows you to indicate if the search includes achievements for which the
points have expired, as follows:

e Leave this field blank to include achievements with expired points. This is the default value.
Expired points are not included in the value for Total Points.

e Select Not Expired to exclude achievements with expired points. If all the achievements
awarded the agent have expired points, the agent is not included in the search results.

3. Click Search. A list of agents meeting the search criteria is displayed. For each agent listed, the
following summary information is displayed:

52

Agent: The name of the agent.

Agent Status: The status of the agent (active or inactive).

CallCopy Group: All groups to which the agent belongs that were awarded achievements. If the
search criteria exclude a group, that group is not included.

Total Points: The total points awarded to the agent for all awarded achievements included in the
search criteria. This total does not include:

e Any expired points (even if achievements with expired points were included in the search).
e Points awarded to a group excluded from the search.
e Points awarded outside of the specified date range.

Note If the number of total points displayed is 0 (zero), all achievements awarded to the
agent within the specified date range have expired points.
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4. For each agent, you can click View Details to display a list of all achievements awarded to that
agent. For details, see Search for Agents with Awarded Achievements.

View or Delete Awarded Achievements Per Agent

1. On the Coaching tab, click the Achievements menu and then click Awarded Achievements.

2. Onthe Awarded Achievements page, use the search filters to display the agents whose
achievements you want to view or delete. For details, see Search for Agents with Awarded
Achievements.

3. For the desired agent, click View Details. Depending on the search criteria used on the Awarded
Achievements page, a list of achievements awarded to the agent is displayed, as follows:

= Only achievements awarded within the specified date range are listed.

= If you selected Not Expired for the Points Expiration filter, achievements with expired points are
not listed.

= If the Points Expiration filter was left blank, achievements with expired points are listed. The
date that the points expired is displayed in the achievement details.

4. You can view the following summary information for each awarded achievement:

Agent Achievements Detail

Back
Name: Burke, Keith
Achievement Type Points Awarded Date Expiration Date CallCopy Group Action
Correctty Used New Greeting Protocol 5 104282013 01/26/2014 Groupli Delete
Team Competition ] 1140642013 Delete
- 1

Displaying items 1 - 2 of 2

= Achievement Type: The name of the achievement type that was awarded.

= Points: The number of points awarded to the agent for this achievement.

» Awarded Date: The date on which the achievement was awarded.

= Expiration Date: The date, if any, that the awarded points expire.

= CallCopy Group: If the achievement was awarded based on the agent's QA evaluation scores,
this field displays the agent's group assigned to the QA form used for the evaluations. If the
achievement was awarded to one or more groups ad hoc, this field displays all the agent's groups

awarded the achievement. If the achievement was awarded to individual agents, this field is left
blank.

5. To delete this achievement and subtract the points awarded for this achievement from the agent's
total awarded points, click Delete. You are prompted to verify the deletion.
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About Uptivity

About Uptivity

What boosts the bottom line for any company with a contact center? How about getting the best that
every agent can deliver from their first day on the job and constantly optimizing contact center
management and performance? Only Uptivity gives you the tools you need to continuously improve every
aspect of each step of every agent’s life cycle and enhance customer satisfaction. You get exactly what
you need thanks to a modern, integrated, and easy-to-use suite of tools that offers a unified system for
performance management, workforce management, speech analytics, and call recording. Unparalleled
customer service and support from our in-house staff combine with a better bundle for a better value, and
a lower total cost of ownership.

Headquartered in Columbus, Ohio, and on the Web at www.uptivity.com.
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